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 1. When can we interpret a 3D voltage map?  
 

1. When can we interpret a 3D voltage map? 
Traditional EEG training teaches to look out for polarity reversals to identify the negative peak, e.g. of 
interictal spikes. Often, it is assumed that this peak identifies the region of origin: 

 Polarity reversal near C3 Superficial central cortex? Negative pole over region 

However, this concept is too simplistic and may often lead to misinterpretation as you will see 
below. Normally, the negative pole of a dipolar map is not exactly above the region of origin and may in 
fact be quite remote and even over the other hemisphere. Therefore, learn how to consider the whole 
topography including the positive pole to define the region of origin as shown below. 

When using BESA Epilepsy or BESA Research in EEG review mode, you obtain a single 3D map when 
selecting a detected event or clicking on a spike peak or anywhere on the EEG traces. The 3D map 
automatically rotates to a viewpoint related to the center of the current EEG activity. Use the rotation 
buttons right/left, up-down in the mapping window for fast inspection of other viewpoints: 

 Non-dipolar – 2 neg. poles Non-dipolar – bilateral Dipolar – 2 poles, neg. + pos. 

The 3D maps allow for an approximate visual localization of focal brain activity, i.e. if the EEG activity 
originates only in one circumscribed brain region. Focal brain activity produces a dipolar field on the scalp 
with 2 poles, a negative and a positive pole. The size of the poles depends on the location and orientation 
of the active cortical region as we will learn below. First, you need to check if the voltage map is dipolar: 

Rule 1: Check if map is dipolar, i.e. whether it has only one negative and one positive pole! 

In the 3 maps above only the right map is dipolar, since there are 2 opposite poles. The negative pole 
over the left frontal scalp is more focally than the opposite positive pole. Maps with midline foci must 
always be checked carefully if they are bilateral (middle). Then interpretation is complicated and often 
obsolete. 
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 2. How are 3D maps related to cortical activity?  
 

2. How are 3D maps related to cortical activity? 

2.1. Sulcal versus superficial activity in the central region 

Consider a focal activity in the left central region and the related cortical folding. The activation can be in 
a sulcus, on the crown of a gyrus, or involve a patch covering both sulcal and superficial cortex: 

     sulcus = tangential surface = radial normal = oblique 

If we have the idealistic situation of an active fissure perpendicular to the cortical convexity, the voltage 
map is tangential (left). If only the crown of one gyrus (or a larger surface) is involved, the map appears 
radial (middle). Normally, both sulcal and superficial cortex are active and the map is oblique. The 
orientation of the map - thought of as a line in space pointing from the negative to the positive pole - is 
related to the net orientation of the active cortex. Thus, the map is more tangential the more sulcal cortex 
is active (left) and more radial the more superficial cortex is involved (middle, right; see also figure below).  

In a tangential map (left), the center location of the active cortex is below the point on the scalp that is 
half-way between the poles. This corresponds to the area of maximum gradient (thick arrow). In a 
perfectly radial map (middle), the center location coincides with the peak of the negativity. The positive 
pole is on the opposite side of the head. It is weaker and more widespread.  

A focal EEG map usually has a stronger and a weaker pole reflecting the net oblique orientation of the 
underlying active cortical patch (right). The center is closer to the stronger pole near the region with the 
largest gradients, i.e. where the equipotential lines are most dense. 
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2.2. Temporal lobe spikes - influence of the sublobar surfaces 
 

2.2. Temporal lobe spikes - influence of the sublobar surfaces 
Another important situation to understand are interictal spikes at the different cortical surfaces of the 
temporal lobe as shown below. Interictal spikes are cortex negative, i.e. the dipolar currents are flowing 
into the cortex. Thus, we can have initial spike currents into the basal or polar surfaces of the temporal 
lobe – common in mesial temporal lobe epilepsy – or into the anterior or posterior lateral cortex as well as 
downward currents on the upper surface of the temporal lobe within the Sylvian fissure:  

 temporal basal temporal polar  temporal lateral 

On the left, the basal activation presents itself with a near-to-vertical 3D map with a stronger negative 
pole below the inferior temporal electrodes F9, T9, and P9. Depending on the amount of inferior lateral 
cortex involved, the positive pole resides on the same side near C3 (small involvement), near the vertex 
(middle) or even on the contralateral upper scalp (larger).   

In the middle, the activation of the left polar region shows an oblique map with a negative pole on the 
cheek below the left eye. Depending on how much lateral polar cortex is involved, the negative pole may 
appear shifted more to the side, e.g. to F9, while the positive pole moves from posterior ipsilateral to the 
midline or contralateral. Depending on how much basal cortex is involved, the negative pole may be 
shifted to more inferior, e.g. to F11. 

The right 3D map shows the typical radial pattern of a left temporal-anterior spike originating at the lateral 
cortical convexity. The corresponding positive pole is on the other side of the head. Only this pattern 
leads to the typical polarity reversal in the longitudinal bipolar montage.  

The arrows in the basal and polar maps illustrate how to identify the center of activation (larger arrows) 
and the orientation of the underlying net dipolar current by connecting both poles (small arrows). The 
arrow in the lateral map (right) illustrates that the current flows inward into the lateral convexity of the 
temporal lobe. 

As a temporal lobe spike evolves within the first 10-30 ms, several of these surfaces can become active 
simultaneously. For example, you may observe a shift of the negative peak from basal to polar and/or 
from basal to lateral. Then the 3D maps will just be a combination of the 3 basic map types shown above 
similar to the summation of the underlying dipolar currents into a combined equivalent dipole vector. 

Whole head 3D mapping - based e.g. on spherical splines (Perrin et al. 1988) - is required to map these 
inferior negativities. Without inferior electrodes or the whole head 3D mapping, such temporal-basal and 
polar spikes may be easily overlooked. 

 

6 



 3. How can we interpret 3D maps?  
 

3. How can we interpret 3D maps? 

3.1. Consider the net cortical orientation 

Let us consider a situation similar to the activation of the left central gyrus shown above and vary the 
proportion of active sulcal versus superficial cortex in a more moderate way. For better understanding we 
assume that the net orientation of the cortical activity does not change much in the horizontal plane 
(these orientation effects will be demonstrated further below) and center location is the same. 

Using the free DipoleSimulator software (please download from www.besa.de), the azimuthal orientation 
of the net source current was varied to reflect predominantly sulcal (red), intermediate (blue), and 
predominantly superficial (green) activities:  

The corresponding cortical activities and 3D maps are illustrated below: 

 mainly sulcal  intermediate mainly superficial 

The arrows are all at the same position between C3 and Cz located above the simulated source center. 
The negative pole is more anterior in all cases. It is never exactly over the active region, even if the 
superficial activity dominates (right). Thus, we need to consider the whole 3D map to derive the center.  
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3.2. Use some easy rules to define the center of a 3D map 
 

3.2. Use some easy rules to define the center of a 3D map 
As already seen above, a typical focal EEG map has one stronger and one weaker pole. The origin lies 
below the region of largest gradients along the shortest scalp line connecting both poles. It is shifted 
slightly towards the stronger pole, if this is dominant (right). 

Thus, we can derive a set of 5 rules how to estimate the approximate scalp location that is above the 
center of a focal brain activity: 

Rule 1: Check if map is dipolar, i.e. whether it has only one negative and one positive pole. 

Rule 2: Consider the spatial orientation defined by both poles. 

Rule 3: Draw a line mentally from the negative to the positive pole along the scalp.   

This line should follow the shortest route on the scalp (see arrows) and exhibit the highest voltage 
gradients, i.e. where the distance between equipotential lines is most narrow.  

Rule 4: Find the region of highest gradients. 

In a close-to-tangential map, the origin is below the region of highest gradient (near thick arrows). 
However, in oblique maps it is shifted more towards the stronger pole (right), more so if one pole is very 
dominant and if the weaker pole is on the other side of the head.   

Rule 5: Consider the relative strength of the negative and positive pole. 

Following these rules, we could plot the center arrows adequately in all the examples shown above.  

Next, we want to simulate other activations in the left central region that are related to the 3-dimensional 
cortical convolution of a real brain. In the figure below, several sulcal activities at different aspects of the 
precentral sulcus have been assumed (only ~ 2 cm anterior and ~1 cm lateral to the previous generators; 
the interhemispheric fissure can be seen above extending horizontally): 

sulcus facing midline (net) oblique sulcus anterior wall of sulcus 

Interictal spikes are cortex negative, i.e. the current is flowing into the cortical surface. Thus, if a sulcus is 
nearly parallel to and facing the interhemispheric fissure (left), the current direction is from the opposite 
into the active hemisphere. This can create the so-called paradoxical lateralization, i.e. the negative spike 
peak is over the wrong hemisphere (left figure). Following our rules considering both poles and the 
gradients, we can localize more correctly (see arrow on the left and in the middle).  
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 3.3. You may neglect the extent of the activated cortex  
 

Depending on the 3-dimensional orientation of the active patch of cortex, the negativity can be anywhere 
on the upper head from posterior-parietal (right), midline (middle), contralateral (left), to anterior-frontal 
(see previous figure). Yet, if we use the above rules, we can well localize all these activities to the same 
left central region (cf. arrows).  

In addition, considering the surface negativity of spikes we can identify that the anterior wall of the left 
precentral gyrus was activated in the right example of the above figure. Correspondingly, the anterior wall 
of the central fissure was activated in the right example of the figure above as opposed to the activation of 
the posterior wall in the left example of the previous figure. Both walls are just a few mm apart.  

3.3. You may neglect the extent of the activated cortex  
Next, let us observe what influence the size or extent of the activated cortex has: 

surface area 1x surface area 2x surface area 4x 

For reasons of clarity, we assume in this simulation that the net orientation remains the same.  

The surface area of the cortical patch increases from the left by a factor of 2 (middle) and a factor of 4 
(right). Only the magnitude of the map changes by the same factors. There is no obvious change in the 
3D pattern, since the equivalent center does not shift and orientation is stable. Principally, the center 
location on the scalp will not change. A larger area can merely lead to a slightly deeper center that would 
manifest itself in a slightly larger separation of the 2 poles, but the dipolar pattern remains similar. For an 
example, refer to the Hands-on Tutorial 1: ‘Introduction to discrete source analysis’ on www.besa.de.  

Applied to epileptiform interictal spikes, an increased cortical area would lead to changes in EEG peak 
amplitude by similar factors. 
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 4. Real 3D maps of interictal spikes in the scalp EEG  
 

4. Real 3D maps of interictal spikes in the scalp EEG 
Below, we illustrate 3D maps from peaks or onsets of interictal spikes in the scalp EEG recorded from 
patients during long-term presurgical monitoring. The interpretations of the 3D spike maps are consistent 
with other clinical findings in these patients, e.g. seizure onset, brain lesions, source imaging etc.          
We gratefully acknowledge data and advice provided by Thomas Bast (University of Heidelberg; 
Epilepsiezentrum Kork), John Ebersole (University of Chicago), Pal Larsson (University of Oslo), and 
Nobukazu Nakasato (University of Sendai). 

4.1. Temporal lobe interictal spikes 

   left temporal basal left temporal polar left temporal lateral 

The left map center is near T9, the middle map center between F9, F7 and T7 indicating involvement of 
the polar and lateral anterior temporal sublobar surfaces. The right map center is near T7; the positive 
pole on the opposite side confirms the association with left lateral temporal. 

4.2. Frontal lobe interictal spikes 

 left frontal anterior left frontal operculum left frontal operculum 

The left map is related to a left frontal anterior cortical dysplasia. The map center is near F3. The source 
is relatively deep because of the large separation of both poles.  

The middle and right maps reflect the onset and peak topographies of an averaged rolandic spike. They 
exhibit the same center just above and ahead of T7. The vertex positivity in the right map shifts the center 
reconstructed according to our rules up above and ahead of T7, i.e. the same supra-sylvian region as 
identified by the onset map. The orientation of both maps suggests an onset of this rolandic spike at the 
posterior wall of the central sulcus (in the face area – current flows towards posterior) and propagation to 
the lateral and inferior (supra-sylvian) surface of the central gyrus (orientation is partly upward). 
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4.3. Take your own decisions on real spikes 
 

The comparison with the lateral temporal lobe map above shows a similar location of the negative pole in 
both cases. This illustrates that the negative pole alone is insufficient for visual localization. 

left central left central left central 

Three left central spikes with different orientations from one patient. The negativity is not localizing. 
According to our rules, all spikes exhibit the same center just below C3 posterior to FC5. 

4.3. Take your own decisions on real spikes 
Finally, we suggest that you follow the rules outlined above to identify the side, the region of origin and, 
possibly, the sublobar surface in each of the following 6 interictal spike examples: 

Examples 1-2 reflect 2 different spike types of one adult patient. Example 3 is from another adult; 
example 4 from a child, and examples 5-6 reflect the onset and peak maps of an averaged spike of 
another child.  
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 4.3. Take your own decisions on real spikes  
 

You may label your solution by side, region, sublobar surface (e.g. L Tb) using the following 
abbreviations: 

Side:  R=right, L=left, B=bilateral 

Region:  F=frontal, FP=frontal-polar, C=central, P=parietal, O=occipital, T=temporal, TP=temporal-polar 

Surface: l=lateral, b=basal, i=inferior, s=superior, a=anterior, p=posterior, m=mesial (2 surface letters 
may be used, if an oblique orientation suggests 2 lobar aspects to be involved). 

A solution to this challenge can be found on www.besa.de under Tutorials/Quick Guides. You are 
welcome to visit and confirm your success in this training on 3D maps. 
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5.1. Setup BESA Dipole Simulator for VIREPA 
 

5. BESA Dipole Simulator: Play with dipoles and maps 
This chapter illustrates how to use the free BESA Dipole Simulator to inspect and work with the examples 
shown in chapters 1-3. Playing with the provided files will deepen your understanding of maps although 
Dipole Simulator only displays 2D maps, with different viewpoints, however. 

Because of easy setup, we have used version 3.3.0.6 of the Dipole Simulator program by Patrick Berg 
(Nov. 2011) in here. You may download the most recent version with a new user interface and more 
functions, available also for Apple and Linux platforms from www.besa.de.  

5.1. Setup BESA Dipole Simulator for VIREPA 
Download BESA_Dipole-Simulator_Setup.exe from the Updates folder in Unit 1 on the VIREPA 
website. 

Run to expand into the default folder C:\VIREPA-SA\Xtras\BESA_Dipole-Simulator. You may modify this 
path if desired, but it is advised to keep it to have all programs and data combined in C:\VIREPA-SA. 

Open this folder, right click onto the program DipoleSimulator.exe and select Pin to Taskbar. 

5.2. Start and adjust BESA Dipole Simulator 

• Click onto the Dipole Simulator icon in the taskbar to start. 

• Maximize the window or Drag the lower boundary down to view the 3 windows fully. 

• Press the load model button (3rd from left – move mouse slowly over buttons to show function). 

• Open the model file 2-1_Radial-Tangential-Oblique_CL.mod. Note: The numbers refer to the 
chapters earlier in this Quick Guide where this example is explained and shown using 3D maps. 

• Drag the vertical boundary between the source and scalp waveform windows a bit to the left to have 
a better view of the scalp waveforms. If needed, you may adjust scales at the upper right of each 
window. Do not use the lower scaling bars in the scalp EEG window unless you want to add noise. 
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 5.3. Play with the location and orientation of a dipole  
 

 

• The left window depicts the head scheme with the dipoles defined by location (dot) and orientation 
(arrow).  

• The middle window shows the unit map of each dipole and its source waveform modeled by spline 
functions going through the squares (points defined by time/latency and amplitude - here zero – peak 
– zero).  

• The right window shows the scalp EEG using the standard Av33 electrodes in reference-free 
montage with negativity pointing upwards. 

• Double click above the first peak to set a cursor. This will activate the 2D maps in 6 standard view 
point on the left (as shown above). 

• Use the left / right arrow buttons or Drag the cursor to view the change of maps over time on the 
left. The middle maps are 

      Note: Consult the Help menu for more details on how to use Dipole Simulator. 

5.3. Play with the location and orientation of a dipole 

• Open the model file 2-1_Radial-Tangential-Oblique_CL.mod.  

• Press <Esc> to remove the cursor to work with  the single (initially) radial dipole on the left. 

• Click onto the dipole dot and Drag to move to a different location. Note: The changes in the scalp 
topography in the top view map in the middle are only modest since orientation does not change. 

• Drag the dipole back to near the original location or reopen the model file. 

• Click onto the tip of the dipole arrow and Drag to rotate the dipole into a different orientation. Note: 
Changes in the scalp topography are enormous and you may succeed in getting the negative peak 
almost anywhere on scalp by changing orientation. Yet, the dipole location is the same!  

• Exercise: Produce the so-called paradoxical lateralization by selecting an orientation that points to 
the other hemisphere. 

 
original 

 
2 cm forward 

 
paradoxical lateralization 

5.4. Understand the effects of overlap 

• Open the model file 2-1_Radial-Tangential-Propagation_CL.mod.  

• Double click to set a cursor and change latency to see the rotation of the map from the initial 
tangential dipole topography into a radial one.  

• Note: You can also create a map series by dragging the lower boundary of DipoleSimulator down to 
reveal the serial map window.  

• Also, drag the right boundary of left window to the left to make head symbols and maps smaller. 

• Select menu item Edit -> Map Sequence and set interval from -40 to 0 ms and choose 9 maps. The 
resulting screen is shown below. 
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5.5. Look though the examples and do your own exercises 
 
 

 
 

5.5. Look though the examples and do your own exercises 

• Open each model file. The following files are available for the examples in chapters 1 to 3: 

 
• Double click to set a cursor and inspect maps and try to understand overlap where this has been 

modeled. For the temporal lobe, in particular, 3 different types of propagation have been modeled. 

• Exercise 1:  Describe the overlap in these 3 cases by looking at the maps only. 

• Exercise 2:  Guess where the negativity will be, if the posterior wall of the right parietal-occipital 
sulcus is spiking. Then, create an according dipole in this regions (File -> New Model; Double Click 
to set dipole and use dot and arrow tip to move and orient). 

• Exercise 3:  Do the same for the mesial and inferior aspects of the anterior cingulate gyrus. 
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